
 

 

  



 

Trading with MT4 

The next step is the reason traders come to the MT4 platform: trading. Here, we’re going to 

cover how to make trades with MetaTrader 4 online. 

How to trade a currency pair using MT4 

The simplest way to open a trade in MetaTrader 4 is to use the 'Order' window and then 

place an instant order on the market. Select the currency pair of your choice by clicking on 

the 'Window' tab at the top of the MT4 platform, and then select 'New Window'. You can 

then click 'New Order' on the MT4 toolbar or press F9 to open an 'Order' window. 

The screenshot below displays an 'Order' window for the EUR/USD currency pair. From this, 

you should be able to see how easy it is to buy and sell with MetaTrader 4. To trade at the 

market bid/offer, you would need to enter your desired trade size (in lots) in the 'Volume' 

box and then click 'Sell or Buy', with 'Market Execution' selected as the order type. 

It is the 'Market Execution' setting that allows an instant order within MetaTrader 4. Of 

course, dealing at the market is not the only answer to the question of how to make a trade 

within MetaTrader 4. 

You can also choose to buy or sell using a limit or a stop order, by selecting your choice from 

the 'Type' dropdown. This is how to buy and sell on MetaTrader 4 at specific, desired levels 

away from the current market price, as opposed to executing immediately at the prevailing 

price. 

 

 

 

 

 

 



 

How to enter a short position on MT4 

Going short (or short selling) on a market is simply selling when you do not have a long 

position. To do so, you would simply need to place a sell trade to open (as demonstrated in 

the screenshot image above). 

How to close a trade in MT4 

How to place a trade with MetaTrader 4 is only part of the information that a trader needs, 

of course. Once you've opened a trade, there will eventually come a point when you want to 

close the trade. 

So how do I exit a trade in MetaTrader 4? Select the 'Trade' tab from the 'Terminal' window 

(press CTRL+T to summon or dismiss the 'Terminal' window). You will see any open trades 

you have displayed in the 'Trade' section of the 'Terminal' window. Right-click on the order 

you wish to close and select 'Close Order'. 

This opens an 'Order' window. Click the yellow 'Close' button to close your trade. So if you 

have two positions or more open in MetaTrader 4, and are wondering how to close one, this 

manual method is the way to do it, as you are specifying which individual trade you wish to 

exit. 

This manual method is not the only answer for how to exit a trade in MetaTrader 4 though. 

You can also close using a stop loss or limit order. 

How to set a stop-loss in MT4 

As you can see from the 'Order' window (shown in the screenshot still below), there are 

fields provided for you to enter a 'Stop Loss' level and a 'Take Profit' level. If you click on 

either the up or down arrow in the 'Stop Loss' field, the box will automatically populate with 

the current market price (the platform uses the bid price). On the tick chart on the left, you 

can see how your proposed stop level relates to the current bid and offer prices. 

 

 



 

How to place a limit order in MT4 

To place a limit order to close a position, you simply enter a target price level in the 'Take 

Profit' field shown in the 'Order' window (as demonstrated above). You can also use a limit 

order to open a position. To do this, you need to change the 'Type' field from 'Market 

Execution' to 'Pending Order'. You can then choose 'Buy Limit' or 'Sell Limit' from the 

'Pending Order Type' dropdown menu as required. 

How to set orders by pips as default in MT4 

If you add a stop-loss or a take-profit order when you open a trade, the default functionality 

is for the order levels to be expressed in absolute market levels. Once you have added a 

stop or a limit order in this way, you can then go to the 'Trade' tab in the 'Terminal' window 

(CTRL+T to open or close this window) and right-click on the trade you are interested in and 

choose 'Modify' or 'Delete Order'. 

This opens an 'Order' window that will now allow you to amend your order levels in terms of 

point (not pips) away from the current market price. To modify the behaviour in MT4 to 

allow you to specify stop and limit orders as pips as a default, you would need to run a script 

or an EA (Expert Advisor) to modify the platform's functionality. 

How to change the volume of a trade in MT4 

In MetaTrader 4, the volume of a trade refers to the size of the trade in terms of the number 

of lots. As we discussed above, when you open a trade, you need to specify a value in the 

'Volume' field of the 'Order' window. 

Once you have opened a trade in a certain market, you can add to the volume (or the 

position size) by opening a further position in the same direction on the same market 

(obviously at a new price), or you can reduce the volume by part-closing your position. 

 

 

 



 

How to trade company stocks in MT4 

Trading CFDs on shares with MT4 isn't much different from trading Forex. An easy way to 

see a list of share CFD prices in MT4 is to open the 'Market Watch' window (CTRL+M to open 

and close). From that list, if you want to open a price chart, simply right-click on the 

'Symbol' that you're interested in and select 'Chart Window'. 

Alternatively, you can click on 'Window' at the top of the MT4 platform and select 'New 

Window' and then Share CFDs. This will give you a list of shares that you can trade. When 

you have the share of your choice in a chart window, just click on 'New Order' on the toolbar 

to open an 'Order' window. From there, it's just a matter of simply choosing your trade size 

and choosing whether to deal at market or work a limit or stop order. 

If you do not see the share that you are interested in displayed within the 'Market Watch' 

window, then you need to know how to add stocks to MetaTrader 4. This is simple – just use 

the shortcut CTRL+U and look for the Share CFDs folders in the navigation tree.  

To add to the list displayed in 'Market Watch', you would just have to click 'Show' and then 

'Close'. The desired price would now appear as the last listed item in the 'Market Watch' 

window, and that is how to add CFDs to MetaTrader 4. 

How to add indices to MT4 

Open the 'Market Watch' window (shortcut CTRL+M). Right-click within the window and 

select 'Symbols' (you can also jump directly to this using the shortcut CTRL+U). Look for the 

folders in the navigation tree called 'Cash Indices'. Expand them to reveal the available 

stock index CFDs. 

If you would like to add one to your 'Market Watch' window, simply select it and then click 

'Show'. Click 'Close' when you have finished with the 'Symbols' window, and your new 

instrument should appear at the bottom of the 'Market Watch' window. 

How to add commodities to MT4 

Adding commodities to MT4 is very similar to the process described above for CFDs on 

shares and indices. Let's say that you want to know how to add Gold and Silver to 

MetaTrader 4. Use the shortcut CTRL+U to open the 'Symbols' window. Look for the 'Spot 

Metals' folders. Expanding the 'Spot Metals 1' folder reveals 'GOLD' and 'SILVER'. 

Select whichever one you want to add and then click 'Show' and 'Close'. The specified 

instrument will now appear at the bottom of the price list in the 'Market Watch' window 

(press CTRL+M to open and close the 'Market Watch' window). If in doubt, right-click on the 

'Market Watch' window and select 'Show All', which will display all available instruments. 

How to add currency pairs in MT4 

Just as described above, if there is a particular currency pair that you want to trade, but 

cannot see in 'Market Watch', you can use the shortcut 'CTRL+U' to open the 'Symbols' 

window and look through the navigation tree for any currency pairs that you would like to 

add. To add a pair, simply click on the symbol and click 'Show'. Alternatively, to display all 
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instruments available for trading, right-click in the 'Market Watch' window and select 'Show 

All'. 

How to navigate MT4 

You now know how to place trades in the MT4 platform. But there is more to this platform 

than just trading. Now, we will cover the rest of the MT4 features. 

How to show terminal in MT4 

You can open or close the 'Terminal' window using the shortcut 'CTRL+T'. 

How to show trade history in MT4 

You can view trade history in MT4 via the 'Terminal' window, which you can open and close 

using the shortcut 'CTRL+T'. In the 'Terminal' window, click on the 'Account History' tab. 

Right-click anywhere in this window and you will see a menu providing you with a choice of 

options, including 'All History', 'Last 3 Months', and 'Last Month'. You can also choose to 

save a 'Detailed Report'. 

This includes all the trading information you might need, such as prize, size, MetaTrader 4 

trade execution time, and profit/loss. If you want to know how to print your account history 

within MetaTrader 4, simply choose 'Save as Report' or 'Save as Detailed Report'. This will 

save the report as an 'HTML' file. If you open the file, it will open in your web browser. In 

your web browser, click the 'Edit' tab and choose 'Select All' (or use the shortcut CTRL+A). 

Once you have selected all, right-click and choose 'Copy'. Now, open a word processing 

application, such as Microsoft Word or Google Docs, and paste the copied data. You can 

then format the account balance data as you desire, and you can then print using the 

application's print function. 

How to show trading history on a chart in MT4 

It's simple to display a trade from your account history directly on a chart in MT4. Open the 

'Terminal' window (CTRL+T to open and close) and select the 'Account History' tab. Click on 

a trade in the window and drag it to a chart window. 

The chart will now display the instrument of the trade, and the opening and closing levels 

will be marked on the chart with small arrows, joined by a dashed line. If you hold the 

cursor over the arrows, the trade information will appear as hover text. 

How to view open trades in MT4 

As with above, you can view open trades by using the 'Terminal' window. You can see your 

open trades by clicking on the 'Trade' tab. 

How to check how much money I have with MT4 

To check the balance of your trading account, open the 'Terminal' window (CTRL+T to open 

and close) and select the 'Trade' tab. You will be able to see your 'Balance' displayed along 

with 'Equity' and your amount of 'Free Margin'. 



 

 

How to change the colour of trade levels in MT4 

As a default setting, MT4 will display levels on a price chart for any open trades you have in 

a position. The defaults are a green dotted line for entry-level, and a red dotted line for both 

a stop-loss level and a limit (take-profit) level. Changing the colour of trade levels is the 

same process as customising any other colours in MT4 – in other words, it is completed by 

accessing 'Properties'. 

To do this, right-click on your price chart and select 'Properties' (or use F8 as a shortcut). 

From here, you can customise the colour of the stop levels. You can also choose to turn 

these order level lines off entirely. To do this, choose 'Tools' from the menu bar at the top of 

the platform and then select 'Options'. In the 'Options' window, uncheck 'Show' trade levels 

if you wish to switch this function off. 

How to change the chart background in MT4 

Once again, this is controlled from the 'Properties' section in MT4. Press F8 to open 

'Properties' and ensure you have the 'Colors' tab selected. The first item on the list is the 

background colour. Just click on the dropdown menu and make your choice. 

How to turn off an indicator in MT4 

To turn an indicator off, use the shortcut 'CTRL+I' to display your list of indicators. Select 

the indicator you want to turn off by clicking on it and then click on the 'Delete' button. 

How to find WMA in MT4 

A weighted moving average (or WMA) is a type of moving average and therefore can be 

found as part of the Moving Average Indicator in MT4. First, add the MA indicator to your 

chart by double-clicking on 'Moving Average' in the 'Indicators' folder of your 'Navigator'. 

This opens a dialogue window in which you set the indicator's parameters. 'MA Method' 

dictates which type of moving average you'll be using. Selecting 'Linear Weighted' gives you 

a 'Linear Weighted Moving Average' (LWMA). 
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How to add templates to MT4 

It is very easy to customise the look of a chart in MT4. To do this, right-click on your chart, 

select 'Properties', and then click on the 'Colors' tab. From there, you can choose to 

customise the colours of the background, the foreground, your up and down candles, and so 

on. Having done so, you might like to save that look and feel for future use. 

You do this by saving it as a template. Right-click on your chart again and this time, choose 

'Template' and then 'Save Template'. Once you have saved a template, it is very easy to add 

it to a new chart. To do so, simply right-click on your chart and choose 'Template' and then 

'Load Template'. You can read more about 'Templates' and 'Profiles' on the MQL4 Website. 

 

How to draw a short line in MT4 

Adding trendlines to charts can be a very useful tool. The default behaviour when you use 

the 'Draw' trendline tool (the button with the diagonal line on the toolbar) is to draw a line 

that extends all the way to the far right of the screen. There may be times, however, when 

you just want a shorter line instead. To do this you need to: 

Turn off your line's ray behaviour 
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Double-click on your trendline 

This puts the line into edit mode. Now that you have it in edit mode, right-click on the line 

and choose 'Trendline' properties. 

In the 'Trendline' window, select the 'Parameters' tab and uncheck 'Ray'. Now, you will have 

short trendlines. 

How to make trend lines permanent in MT4 

If you want a trendline on a certain currency pair to re-appear the next time you look at that 

pair, you'll have to save your work as a template. 

To do this, either click on 'Chart' from the menu bar at the top of the platform and then 

'Template' and then 'Save Template', or right-click on your chart and from there choose 

'Template' and then 'Save Template'. If you close MT4 and find that you want your analysis 

lines again, all you have to do is go to 'Template' and this time, click on 'Load Template'. 

Then, select whichever filename you saved your work under, and all your saved trendlines 

will re-appear. 

How to make the screen larger on MT4 

There is only so much real-estate available on your screen to display the various windows 

you have open in MT4. Closing certain windows, therefore, will cause the remaining 

windows to enlarge. 

Closing the 'Navigator' window, for example, will cause a price chart to increase in size and 

take up the newly-available space. Press 'CTRL+N' to toggle the 'Navigator' window on and 

off. Similarly, you can use 'CTRL+T' to toggle the 'Terminal' window on and off. 

How to scale in on MT4 

You can zoom in and out on a chart using the + and - keys. 

How to scroll in MT4 

You can use the cursor keys to scroll left and right on a chart in MT4. The 'Page Up' and 

'Page Down' keys will fast scroll to the left and right, respectively. 

How to show pips in MT4 

You can monitor your running profit for your open trades by looking in the 'Trade' tab in the 

'Terminal' window (CTRL+T to open and close the Terminal window). Profit is displayed in 

your deposit currency by default, but it is easy to switch this to display as pips instead. 

To do so, right-click in the 'Trade' window and select 'Profit'. Then choose 'Points' instead of 

'Deposit' currency. 10 points are equal to one pip with fractional pricing. 



 

 

How to set notifications on MT4 

You will want to get MetaTrader 4 notifications. Choose the 'Alerts' tab from the 'Terminal' 

window (CTRL+T to open and close). Right-click anywhere in the 'Alerts' window and 

choose 'Create'. 

You then need to fill in the criteria for the alert, such as, which market you wish to place the 

alert on, what 'Value' (that is, price); which 'Condition' to apply (such as if the Bid is less 

than a certain price, or if the Ask is less than a certain price, etc.) and when you wish the 

alert to expire. 

How to enable email alerts in MT4 

One specific form MetaTrader alerts that some traders prefer those via email. 'CTRL+O' 

shortcut to open the 'Options' window and click on the 'Email' tab. You then need to fill in 

the fields to configure which email server and address are being used for relaying the email 

alerts to you and also to which email address you want to ultimately receive the alerts. 

First, click 'Enable' and then fill in the various fields. You may find for the 'SMTP' (Simple 

Mail Transfer Protocol) configuration fields that it is worth creating a Gmail account for the 

sole purpose of relaying these messages on to your existing email account. Make sure to 

click 'Test' to check that it works before clicking OK. 



 

 

 

How to update MT4 

MT4 should automatically update itself to the latest version whenever a new update is 

released by MetaQuotes, the software company behind the MetaTrader family of platforms. 

You can see which version of MetaTrader 4 you are running by clicking 'Help' at the top of 

the MT4 platform and then selecting 'About'. 

How to change timezone in MT4 

The MetaTrader 4 brokers you connect with determine the timezone displayed in your MT4 

platform. You cannot change it locally on your device. So the only real answer for how to 

change the time on MetaTrader 4 is to use a broker that uses a different timezone. 

How to select your server in MT4 

Select 'File' from the menu bar at the top of the MT4 platform and then 'Login to Trade 

Account'. The resulting popup offers you a 'Server' option, from which you can specify a 

different server. 
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How to mark the days in MT4 

Using the hotkey combination 'CTRL+Y' to show (or hide) separators allows you to mark 

days clearly on your hourly MT4 charts. On a daily chart, the separators will mark the 

beginning of the month. 

How to restore MT4 to default 

To restore a chart to its default settings, simply right-click on a chart and select 'Properties'. 

From the 'Properties' window, choose the 'Common' tab and then click on the 'Reset' button 

at the bottom. If you wish to restore your whole platform to default condition, the 'nuclear' 

option is to re-install MT4 on your device. 

How to refresh MT4 

If you have MT4 open for a long time, sometimes, you may see gaps start to appear in chart 

data. You may be able to rectify this with a simple refresh – right-click on the chart and 

select 'Refresh' from the menu. Sometimes, you may have to go further and do a full manual 

reset of the chart data. 
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